User’s Guide
Contents

Introduction

Features ......................................................... 6

Chapter 1 Installing StylusRIP Professional in Your PC

System Requirements .................................... 7
What to Check Before Setting Up StylusRIP Professional ... 9
Installation ......................................................... 10
Installing a Printer Driver to the Client Computer ........ 26
Sharing a Printer in Windows 2000/XP: .................... 26
For Windows 98 Second Edition / Me .................... 29
For Windows 2000 / XP ........................................ 29
Uninstalling Procedure ...................................... 31
Uninstalling StylusRIP Professional / StylusRIP
   Professional Monitor ...................................... 31
   Uninstalling a Printer Driver .......................... 32
Color Matching ................................................ 33
   CMYK Simulation ........................................... 33
   RGB Simulation ............................................. 33
   Media ....................................................... 33

Chapter 2 Printing With PSserver

Using the PSserver .......................................... 34
Exiting the PSserver .......................................... 36
Checking Print Status ....................................... 36
Starting the PSserver automatically ...................... 38
Using the Preferences Dialog Box ....................... 38
Printing a File Directly .................................... 40
Using Share Folder ........................................... 40
Using TaskTray Icon ......................................... 41
Using Printer Setting Dialog Box ......................... 42
Chapter 3 Troubleshooting

Troubleshooting Hints .................................................. 54
  Cannot select a printer when starting StylusRIP Professional ........................................ 54
  Getting the Best Possible Print Quality ........................................ 55
  Printer prints out illegible type or characters ........................................ 56
  Wrong fonts or jagged type ........................................ 56
  StylusRIP Professional takes a long time before printing starts ........................................ 56
  EPS files do not print ........................................ 56
  Bitmap images or clip art looks jagged ........................................ 57
  TIFF images and simple text files do not print ........................................ 57
  There are white lines on the output ........................................ 57
  StylusRIP Professional does not run from Navigator or other special desktops ........................................ 57
Printout has misplaced images or type ....................... 57
PPD in PageMaker 6.0 is missing .......................... 58
Color matching differs during offset printing with
  Windows Application despite the fact that the product’s
  CMYK simulation function is in use ....................... 58
When a problem occurs with ECP mode ...................... 58

**Glossary**

**Index**
Notes contain important Information and useful tips on the operation of your printer.
Introduction

EPSON® StylusRIP Professional is software for use with Windows® 98 Second Edition, Me, 2000 or XP that turns your EPSON Stylus™ printer into a PostScript® printer. StylusRIP Professional processes raster images for your PC, reads and interprets Adobe PostScript3 and allows your EPSON Stylus printer to print color raster images.

Adobe PostScript is the standard for high quality graphic output. All elements of a document, including text, graphics, and images are processed, stored, and reproduced using the PostScript code. When you print from an application, such as PageMaker®, StylusRIP Professional processes the PostScript code and sends the processed image to the printer.

Note:
The screens used in this manual is an example when the EPSON Stylus Pro 7600 is connected. The model name on the screen will differ depending on the printer used.

Features

- Enables PostScript printing
  StylusRIP Professional enables an EPSON Stylus printer connected to a PC to perform as a PostScript printer.

- Compliance with the network
  By using the folder sharing function of Windows you can print from other PCs on the network.
Chapter 1

Installing StylusRIP Professional in Your PC

Before you install the StylusRIP Professional software in your PC, make sure your PC meets the system requirements listed below.

System Requirements

Your PC needs to meet the following configuration requirements to use StylusRIP Professional, whether in a standalone or network environment:

- At least 64 MB of RAM (128 MB recommended). Also, any memory requirements for optional software must be added to this total.

- At least 200 MB of available disk space. As the number of files in the jobs folder increases, the amount of required disk space also increases.

- Windows 98 Second Edition, Me, 2000, XP operating system

- CD-ROM drive is required.

- Interface: The StylusRIP Professional supports the following interface connections to the printer.
  - Parallel
  - USB
  - IEEE1394
  - Network
Note:
StylusRIP Professional can use all the interfaces supported by EPSON Standard Windows Driver. Before installing StylusRIP Professional, it is necessary to connect the printer you want to use and install EPSON Standard Windows Driver.
However, EpsonNet 10/100 Base Tx Ext. Print Server (C12C82394*) cannot be used.
What to Check Before Setting Up StylusRIP Professional

Before setting up StylusRIP Professional, make sure your system meets the minimum hardware and software requirements listed above, and install any necessary fonts and printer drivers in your PC. See your font installation software and printer user's guides for more details.

Note:
Read the “README” file provided on the StylusRIP Professional CD-ROM before setting up StylusRIP Professional. The README file contains some important notices and the latest information concerning StylusRIP Professional.

Also, be sure to note the following when setting up StylusRIP Professional.

- Turn off all virus protection. For instructions on how to do this, see your virus protection or Windows documentation.

- Close all other active applications.

- Be sure to print a self test for the printer in question to make sure the printer is operating properly. Also, make sure the printer and PC are connected correctly.
Installation

Note:
- Before installing StylusRIP Professional, it is necessary to connect the printer you want to use and install EPSON Standard Windows Driver. For how to install the driver, refer to your printer’s user’s guide.

- StylusRIP Professional uses the port set by ESPON Standard Windows Driver. For example, if the port of the print destination using EPSON Standard Windows Driver is “LPT1,” StylusRIP Professional also uses “LPT1” automatically to print. Therefore, when installing EPSON Standard Windows Driver, set the port of the print destination to match the printer you are using with StylusRIP Professional.

This section explains how to install the PSserver for Windows. Follow these steps:

For Windows 2000 and XP:

To install PS Driver in Windows 98 Second Edition or Me, see the section entitled “For Windows 98 Second Edition and Me:”.

1. Make sure Windows is running.

2. Insert the CD-ROM into the appropriate drive.

3. The Choose Setup Language dialog box appears automatically.

Note:
If the dialog box does not appear automatically, double-click Setup.exe in the Setup folder on the CD-ROM.
4. Select English and click OK.

5. Continue installation by following the instructions that appear on your screen.

6. When the InstallShield wizard appears, select the printer attached and click the Next button.

7. Continue installation by following the instructions that appear on your screen.
8. When the installation of StylusRIP Professional is finished, the following dialog appears. Click the Finish button. The installation of PS Driver begins.

9. The Add Printer wizard starts and the installation of PS Driver begins. Click the Next button and continue the installation.
10. Check Local printer in Local or Network Printer. Do not check Automatically detect and install my Plug and Play printer. Then, click the Next button.

11. Select a printer port. Check Use the following port, and select StylusRIP Professional from the port list. Then, click the Next button.

12. Select a printer model. Click the Have Disk button and specify the location of the INF file. The INF file is saved in the following location on the CD-ROM.
Windows 2000/XP: english\win2000-xp\ps_setup
When you finish selecting, click the OK button.

13. Model names of printers appear. Select the printer attached. Then click the Next button.

14. Continue the installation by following the instructions that appear on your screen.
15. If you are sharing the printer on a network, check Share as: and enter the network printer name. If you are not sharing the printer, check Do not share this printer. Then click the Next button.

![Add Printer Wizard - Printer Sharing](image)

16. If you are sharing the printer, enter Location and Comment. If you are not sharing the printer, this dialog box does not appear. When you finish entering, click the Next button.

![Add Printer Wizard - Location and Comment](image)
17. In Print Test Page, select No, and then click the Next button.

18. When Completing the Add Printer Wizard appears, click the Finish button.
Note:
After the Finish button is clicked, the following dialog box appears in Windows 2000/XP. Click Yes.

19. The installation is now complete. Click the Finish button and restart your computer. You can use StylusRIP Professional after you restart your computer.

For Windows 98 Second Edition and Me:

1. Make sure Windows is running.

2. Insert the CD-ROM into the appropriate drive.
3. The Choose Setup Language dialog box appears automatically.

**Note:**
*If the dialog box does not appear automatically, double-click Setup.exe in the Setup folder on the CD-ROM.*

4. Select English and click OK.

5. Continue installation by following the instructions that appear on your screen.

6. When the InstallShield wizard appears, select the printer attached and click the Next button.
7. Continue installation by following the instructions that appear on your screen.

8. When the installation of StylusRIP Professional is finished, the following dialog appears. Click the Finish button. The installation of PS Driver begins.

9. The Add Printer wizard starts and the installation of PS Driver begins. Click the Next button and continue the installation.
10. Check Local printer in Local or Network Printer. Then, click the Next button.

11. Select a printer model. Click the Have Disk button and specify the location of the INF file. The INF file is saved in the following location on the CD-ROM:

english\win9x\ps_setup

When you finish selecting, click the OK button.
12. Model names of printers appear. Select the printer attached. Then click the Next button.

13. Select a printer port. Select StylusRIP Professional from the port list. Then, click the Next button.
14. Continue the installation by following the instructions that appear on your screen.

15. When the following dialog asking you to print a test page appears, select No and click the Finish button.
16. The installation is now complete. Click the Finish button and restart your computer. You can use StylusRIP Professional after you restart your computer.

To Share a Printer in Windows 98 Second Edition/Me:

If you want to share a printer in Windows 98 Second Edition or Me, and print from a computer connected to a network, share the printer according to the following procedure:

1. Open the Control Panel and double-click Network.
2. Click File and Print Sharing button.

3. Check I want to be able to give others access to my files if you want to share the folder. Check I want to be able to allow others to print to my printer(s) if you want to share the printer driver.

4. Click the OK button.

5. The network dialog box appears. Click the OK button.

6. If you are asked to insert the Windows CD into the CD-ROM drive, insert the CD in the CD-ROM drive, and click the OK button.
7. Restart your computer.

8. Select the printer you want in the Printer window. Then right-click and click Sharing in the menu that appears.

9. Click the Shared As radio button, and select options you want.
10. Click the OK button.

---

**Installing a Printer Driver to the Client Computer**

To print from computers connected to a network using StylusRIP Professional, it is necessary to install a printer driver on each computer. Install the printer driver on each computer according to the following procedure:

**Sharing a Printer in Windows 2000/XP:**

Follow the procedure below if the printer properties were not set up for sharing when the printer driver was installed, or when installing a printer driver for a version of Windows other than Windows 2000/XP.

1. From the Printers folder, select the StylusRIP Professional printer driver that you would like to share.
2. Then right-click the printer and click Sharing in the menu that appears. The Printer Properties dialog box will appear.

3. On the Sharing tab, check Shared as: and enter the name of the printer you want to share.

4. To install a printer driver for a different version of Windows, click Additional Drivers.
5. On the displayed dialog box, check the box adjacent to the version of Windows you want to install, and click OK.

6. Continue the setup procedure by following the on-screen instructions. Select the location of the printer driver when prompted.

   The printer driver for Windows 98/Me is located on the CD-ROM in the following directory.

   english\win9x\ps_setup

7. Complete the setup by following the on-screen instructions.

8. After the printer driver is successfully installed, click OK to close the Printer Properties dialog box.

   **Note**
   By clicking Additional Drivers and installing a printer driver for a different version of Windows, you can then use a client computer to select the shared StylusRIP printer as a network printer, and the printer driver will be installed automatically.
For Windows 98 Second Edition / Me

1. Insert the CD-ROM shipped with EPSON StylusRIP Professional into your CD-ROM drive.

2. Click Start, then Settings, and then Printers.

3. Double-click the Add Printer icon.

4. The Add Printer Wizard will be displayed. Follow the on-screen instructions to add the printer.

5. Select Network Printer once “How is this printer attached to your computer?” appears in order to proceed to the next step.

6. Enter the printer’s network path in the “Network path or Queue name” field. The network printer may also be selected by clicking Browse.

7. When the screen asking you to select the printer type is displayed, click Have Disk and specify the path to the INF file containing installation information. If your CD-ROM drive is D:, the path will be D:\ENGLISH\WIN9X\ps_setup (change the drive letter as needed for your system).

8. Select the correct model and install according to the on-screen instructions.

9. When the installation is done, click Finish.

10. The driver file will be copied to complete the installation.

For Windows 2000 / XP

1. Insert the CD-ROM shipped with EPSON StylusRIP Professional into your CD-ROM drive.

2. Click Start, then Settings, and then Printers.

3. Double-click the Add Printer icon.
4. The Add Printer Wizard will be displayed. Follow the on-screen instructions to add the printer.

5. Select **Network Printer** once “How is this printer attached to your computer?” appears in order to proceed to the next step.

6. Either enter the printer’s network path or click **Next** to select the network printer.

7. Click **OK** once the following message has appeared. “The server on which the XXX printer resides does not have the correct printer driver installed.”

8. When the screen asking you to select the printer type is displayed, click **Have Disk** and specify the path to the INF file containing installation information. If your CD-ROM drive is D:, the path will be D:\ENGLISH\WIN2000-XP\PS_SETUP (change the drive letter as needed for your system).

9. Select the correct model and install according to the on-screen instructions.

10. When the installation is complete, click **Finish**.

11. The driver file will be copied to complete the installation.
Uninstalling Procedure

The StylusRIP Professional installer has installed the following programs:

- EPSON StylusRIP Professional
- EPSON StylusRIP Professional Monitor
- Printer drivers

These programs must be uninstalled separately. To uninstall the StylusRIP Professional programs, follow the procedure below:

Uninstalling StylusRIP Professional / StylusRIP Professional Monitor

1. Click Start, then Settings, and then Control Panel.

2. Double-click the Add/Remove Program icon.

3. Select the program you want to uninstall.
   Select EPSON StylusRIP Professional in this case.

4. If you are using Windows 98 Second Edition or Me, click the Add/Remove button. If you are using Windows 2000 or XP, click the Change/Remove button.

5. When the uninstalling of EPSON StylusRIP Professional is complete, a message appears. Click the Finish button.

6. A message confirming the uninstallation EPSON StylusRIP Professional Monitor appears. Click the OK button.

7. Select EPSON StylusRIP Professional Monitor in the Add/Remove Program dialog box again.
8. If you are using Windows 98 Second Edition or Me, click the Add/Remove button. If you are using Windows 2000 or XP, click the Change/Remove button.

9. When the uninstallation of EPSON StylusRIP Professional Monitor is complete, a message appears. Click the Finish button.

**Uninstalling a Printer Driver**

After uninstalling both EPSON StylusRIP Professional and EPSON StylusRIP Professional Monitor, uninstall the printer driver.

**For Windows 98 Second Edition / Me:**

1. Click Start, then Settings, and then Printers.

2. Right-click the icon representing the installed printer, and then select Delete.

**For Windows 2000 / XP:**

1. Click Start, then Settings, and finally Printers.

2. Right-click the icon representing the installed printer, and then select Delete. The icon will be deleted from the Printer window.

3. To delete a driver file, right-click in the Printer window with the icon unselected, and then select Server Properties from the menu that appears.

4. Click the Drivers tab in the Print Server Properties dialog box.

5. Select the printer you just deleted from the Installed printer driver list, and then click the Remove button.
**Color Matching**

StylusRIP Professional has a function to simulate printing of CMYK colors on a printing press. By using this simulation function, printing can be performed by matching colors with the final colors on the printing press. Because StylusRIP Professional also has a function to simulate printing of RGB colors, and is preinstalled with a color profile for print media, comprehensive color matching can be accomplished.

**CMYK Simulation**

Color matching for the CMYK inks of the printing press can be performed. For this purpose, a standard CMYK profile is preinstalled.

**RGB Simulation**

Color matching for various RGB color spaces can be performed. For this purpose, a standard RGB profile is preinstalled.

**Media**

Color matching for various print media can be performed. For this purpose, a profile for special paper made by EPSON is preinstalled.

*Note:*

*StylusRIP Professional performs color matching by using the ICC (International Color Consortium) profile. Color matching is achieved by a function of ICM 2.0 or later.*
Chapter 2

Printing With PSserver

The PSserver is software that can play the role of print server. When you send a print job (when you save a document as a file, the file extension must be “.ps”) from your application program, the PSserver receives the print job and puts it in a print queue in the order it was received. When your print job reaches the top of the queue, the PSserver sends it to the printer to be printed. The PSserver, just like any other application, must be opened before you can use it.

Using the PSserver

Start PSserver according to the procedure below. If you are starting StylusRIP Professional for the first time, it is necessary to select a printer and enter a license key.

1. Turn on the printer. Make sure the printer's power light is on before you open the PSserver.

2. Click the Start button, select Program and then EPSON, and click StylusRIP Professional.
3. If you are starting StylusRIP Professional for the first time, the Select Printer dialog box appears. Select the printer attached and click the OK button.

4. A dialog box asking you to enter a license key appears. Enter the license key and click the OK button.

Note:
- The license key is written on the CD-ROM case.
- Enter the license key the first time you start StylusRIP Professional. It is not necessary to enter the license key for the subsequent startups.

5. PSserver starts, and you can now print.
Exiting the PSserver

Close the PSserver by clicking the close box on the top right corner of the PSserver window. Keep in mind that you need to open StylusRIP Professional every time before printing.

Note:
Unless your PC is low on memory, you do not need to exit StylusRIP Professional after every print job. You can leave it active until you turn off your PC.

Checking Print Status

In the main window of PSserver, the print status of the print job currently being processed appears.

You can hide the main window by selecting Hide Window on the Window menu. To re-display the main window, select Show Window on the Window menu.

The following information appears in the main window.

Name of the job being processed:
Displays the name of the print job currently being processed. If printing is being performed from application software, the name of the file being printed appears.
Pages:
Displays the total number of pages you are printing and the number of the page currently being printed.

Copies:
Displays the number of copies you are printing.

Status:
Displays the processing status of the current print job.

Progress Bar:
Shows the progress of processing using a bar.

Message Box:
When the Show Message button is clicked, a message box appears. This message box displays details of errors and warnings. If you click the Hide Message button while the message box is being displayed, you can hide the message box.

Note:
You can erase the messages that appear in the message box by selecting Message Clear on the Edit menu.
Starting the PSserver automatically

Follow the steps below if you often use the PSserver. This procedure causes the PSserver to start automatically every time you turn on your PC.

1. Right-click the PSserver icon (which is in C:\StylusRIP Professional\ for default installation), then choose Create Shortcut.

2. Move the Shortcut into the C:\Win95\Start Menu\StartUp\Programs folder.

Using the Preferences Dialog Box

You can make special preferences settings by choosing Preferences on the Edit menu.

Raster Spool Mode:
This setting turns on or off raster image spooling. The default setting is on. It is on when a check appears in the check box. Click the check box to turn it on or off.
Turning on raster image spooling is recommended to get the following benefits:

(1). Faster ripping of multiple copies.
   When 2 or more copies of one PostScript print job are sent to the printer, StylusRIP Professional only rips the job once. This saves time and frees up hardware resources.

(2). Faster ripping
   When this setting is on, StylusRIP Professional spools raster images to the hard drive faster than it can output the print data to the printer. Because of this, StylusRIP Professional is ready to receive the next print job much quicker.
   The drawback with spooling raster images is that spooling requires a lot of free space on your hard disk. The amount of free disk space that your print job requires depends on the size of, resolution of, and amount of detail in the print job. If you do not have enough space on your hard disk, StylusRIP Professional stops spooling when the hard disk becomes full and restarts spooling as soon as the previous print job is finished. This can cause slower performance than if Raster Spool Mode is turned off.

Note:
If you turn Raster Spool Mode on or off, you must quit and restart StylusRIP Professional before the new setting takes effect.

Print After Spool:
When this setting is on, all print data will be spooled to the hard disk and then printed.

Hide Taskbar Icon:
When this setting is set to on, the icons do not appear on the taskbar when the main window is minimized, but appear on the task tray instead. The default setting is off.

RIP Memory Size:
This sets the size of the memory used by StylusRIP Professional.
Printing a File Directly

StylusRIP Professional is capable of printing directly from a PS (.ps) or PDF (.pdf) file you select. Since you will directly select a file, it is not necessary to open any application. Select and print a file according to the following procedure:

1. Select Open from the File menu.

2. When a dialog box to select a file appears, select a file you want to print.

3. Click the OK button. The selected file is printed.

Using Share Folder

Share Folder is a function by which StylusRIP Professional directly processes and prints the files copied to Share Folder. No application software is used, and just copying a file (PDF, PS and other file types) that can be directly printed by StylusRIP Professional to Share Folder will start printing. By sharing this folder on a network, you can print by simply copying a file from a computer on the network.

The Share Folder Setting dialog box is displayed by selecting Share Folder on the Edit menu. Specify the location of Share Folder and the monitoring interval in the Share Folder Setting dialog box.
Using TaskTray Icon

When StylusRIP Professional starts, icons also appear on the tasktray. Right-clicking an icon on the tasktray displays the following menu.

**About:**
Displays the version information of StylusRIP Professional.

**Preferences:**
Opens the Preferences dialog box.

**Share Folder Setting:**
Opens the Share Folder Setting dialog box.

**Print Setting:**
Opens the Print Setting dialog box.

**Color Manager:**
Opens the Color Manager dialog box.

**Printer Connection:**
Reselects a printer. Select this item if you want to change your printer connection.

**Restore:**
Restores the minimized StylusRIP Professional main window to the original display.
Open:
Opens a file you want to load into StylusRIP Professional.

Exit:
Quits StylusRIP Professional.

Using Printer Setting Dialog Box

In the Printer Setting dialog box, you can perform print setting when you are printing a PDF or other file by directly selecting it. The Printer Setting dialog box is displayed by selecting Printer Setting on the Edit menu.

If you are printing a file from application software, this setting is not required since print setting will be performed in the printer driver dialog box.

Note:
The contents of Printer Setting vary depending on the printer attached.
**Paper Setting**

Perform settings related to paper.

**Paper Size :**
Specify the size of the print paper.

**Paper Source :**
Specify the location of the paper source if the printer has multiple paper feeders.

**Print Setting**

Perform settings related to printing.

**Media Quality :**
Specify the type of print paper and the quality of printing.

**RGB Simulation :**
Specify the RGB color space to be simulated when you are printing RGB color data.

**CMYK Simulation :**
Specify the ink colors to be simulated when you are printing CMYK color data.

**Grayscale Control :**
Specify the type of data to be printed using only black ink when you are printing the gray part of color data.

**Ink :**
Specify to print in color, or black and white.

**Other Settings :**
Other settings include a hardware dependent setting and a setting specific to the printer attached. The corresponding function can be enabled by clicking its checkbox. The setting items to be displayed vary depending on the printer attached.
Using Color Manager Dialog Box

You can adjust print colors by changing any of the color profiles of CMYK, RGB and various print media. The Color Manager dialog box is displayed by selecting Color Manager on the Edit menu.

CMYK

You can change the color profile for the CMYK simulation. Select the CMYK simulation whose setting you want to change from the pull-down menu.

ICC Profile :
Displays the ICC profile to be used for the selected CMYK simulation. To change the ICC profile, click the + button and select an ICC profile. Be sure to select a CMYK profile as the ICC profile.

Color Adjust :
Displays whether or not Color Adjust is enabled for the selected CMYK simulation. To enable Color Adjust, click the TC button in the right of the Color Adjust box to display the Tone Curve dialog box, and then change and save the setting.
**Tone Curve Dialog Box:**
This dialog box is used to change the tone curve of each color of cyan, magenta, yellow and black. Select the color you want to edit from the pull-down menu, drag the pointer of the tone curve with the mouse, and then edit the curve. When editing of each color is completed, click the Save button and save the setting.

![Tone Curve Dialog Box - EPSON_DIC](image)

**RGB**
You can change the color profile for the RGB simulation. Select the RGB simulation whose setting you want to change from the pull-down menu.

**ICC Profile:**
Displays the ICC profile to be used for the selected RGB simulation. To change the ICC profile, click the + button and select an ICC profile. Be sure to select an RGB profile as the ICC profile.

**Media**
You can change the color profile for the print media. Select the media whose setting you want to change from the pull-down menu.
ICC Profile:
Displays the ICC profile to be used for the selected media. To change the ICC profile, click the + button and select an ICC profile. Be sure to select the profile for the media to be used as the ICC profile.

Calibration:
You can print the calibration sheet and select calibration table data.
When the Printer icon is clicked, the calibration sheet is printed to the printer attached. The printed calibration sheet is used to measure colors by using the optional EPSON Color Calibrator and to create a calibration table. Click the + button and then select a data file for the calibration table. The selected file name is displayed in the box.

Note:
For how to use EPSON Color Calibrator and how to create the calibration table, refer to the EPSON Color Calibrator User’s Guide.

Paper Configuration:
Displays the print setting for the media that has been set up. When the + button is clicked, the Paper Configuration dialog box appears. You can then change the print setting for the media.
Paper Configuration Dialog Box:
This dialog box is used to change the print setting for the media. The items that can be set up vary depending on the printer attached.

Using the Device Options Menu

You can set the following Device Options in the Printer properties window. To set Device Options, click the Properties button in a window that appears by selecting File and then Print. Then, select the Device Options tab.

*Note:*
Device Options are dependent on the functions of the printer. Depending on the printer you are attaching, some of the following functions may not be used.

Media Type

Specify the type of paper you are using for printing and the print quality.
Resolution

Set the print resolution. Note that not all resolution settings may be selected, depending on the setting of Media Type.

Ink

Specify to print in color, or black and white.

High Speed

Specify whether or not bi-directional printing will be performed. When this is checked, bi-directional printing will be performed, and, as a result, the printing speed will get faster.

CMYK Simulation

Specify the ink colors to be simulated when you are printing CMYK color data.

RGB Simulation

Specify the color space of RGB colors to be simulated when you are printing RGB color data.

Grayscale Control

Specify the type of data to be printed using only black ink when you are printing the gray part of color data.

Auto Cut

Specify auto cut of paper when the optional Auto Cutter is installed.
**Auto Rotate**

Specify to auto rotate the print direction according to the width of the rolled paper set in Paper Source.

**Print Page Line**

Specify to print a [page separation line.] when printing is completed.

**Super MicroWeave**

Specify the setting for more detailed microweave printing.

**Paper Source**

Specify the paper feed method.

**No Margin**

Specify no four-corner margin printing for single form paper, and no left and right margin printing for roll paper. To perform no margin printing, it is necessary to set the custom paper size.

**Note:**

- Certain types of paper cannot be used for printing without margins. Check the manual supplied with the paper for the types of paper that can be used.

- Check the printer’s User’s Guide for the paper size that can be used for printing without margins.
Changing the Graphics Resolution setting

On the Device Option menu, a ☑ symbol appears beside the Media Type setting you want to select in the Change settings for drop-down list, follow the steps below.

1. Select the media type in the Change settings for drop-down list.
2. Click the Graphics tab.

3. Select setting that does not have a ☑ symbol beside it the resolution in the Resolution drop-down list.

4. Click OK.
Note:

- When using ink other than Photo black+Light black in a printer with a replaceable black ink cartridge, or after changing the ink set, you must make the necessary changes to the printer driver settings. (Photo black+Light black is the default ink setting.)

- StylusPhoto2100 and StylusPhoto2200 only support Photo black+Light black ink. These printers do not print using Matte black+Light black or Matte black+Matte black ink.

1. From the Start Menu, select Settings > Printer.

2. Right-click on EPSON StylusRIP XXXXX and select Properties.

3. Select the Device Settings tab from the displayed dialog box.

Windows 98
4. Select the black ink for the optional Black Ink Combination setting.

5. Click the appropriate button and then click OK to close the dialog box.
This chapter lists possible solutions for common problems. Please refer to the troubleshooting hints before calling technical support.

When calling for technical assistance, be ready to identify your system and its configuration, the serial number of your copy of StylusRIP Professional, and a description of the problems you are encountering.

**Troubleshooting Hints**

This section includes the most common problems StylusRIP Professional users may encounter. These problems may include several possible solutions.

**Cannot select a printer when starting StylusRIP Professional**

Check whether or not the EPSON Standard Windows Driver that has been shipped with the printer attached is already installed. If the EPSON Standard Windows Driver is already installed, check whether or not you can print using that printer driver.
**Getting the Best Possible Print Quality**

The StylusRIP Professional is a true Adobe PostScript3 raster image processor, which means it can utilize color rendering dictionaries when the RIP is driving a color printer. Adobe Photoshop automatically accesses these color rendering dictionaries when directly printing to the printer. Images created in Photoshop can be placed in other applications and still access color rendering dictionaries by saving them as LAB.EPS or calibrated RGB.EPS files. Note that color rendering dictionaries are not accessed by RGB.TIF or CMYK.TIF files when they are placed in other applications and printed.

Color profiles for Windows are included with StylusRIP Professional. These ICC color files provide support for printer color adjustment from the application, but only for applications which support this feature.

CMYK files are usually developed in a device-independent space, which makes it possible to adjust specific printing parameters for specific printers instead of accepting the default options given in the color rendering dictionary.

To obtain high-quality color images, keep the following points in mind.

- Use the manufacturer’s inks and recommended paper for your ink jet printer.
- Try using a higher-quality paper. Paper designed for your ink jet printer has special coatings to evenly distribute the ink, and is different from uncoated bond paper used in laser printers and copiers.
- Make sure that you use the correct printer driver (included in the StylusRIP Professional CD-ROM).
- For scanned images, check the scanner software settings.
Perform a print head cleaning; then print a few lines to check the output.

**Printer prints out illegible type or characters**

- StylusRIP Professional can only print to a file. In the printer driver, check that StylusRIP Professional is set to file and not to an LPT port.

**Wrong fonts or jagged type**

- Most fonts are downloaded with the print job. Sometimes a bitmap image of a font is downloaded. If the page is missing a font, StylusRIP Professional will default to the Courier font or print the bitmap image of the font. Make sure you have the printer fonts installed properly.

- If you have the correct printer fonts, try cleaning the print head.

**StylusRIP Professional takes a long time before printing starts**

- Change to a faster CPU or add more RAM. Complex jobs that use a large number of fonts will process faster on a faster CPU or with more RAM. We recommend changing to a faster CPU first, then add more RAM, if necessary.

**EPS files do not print**

- EPS files are designed to be placed into other documents. They cannot be processed directly by StylusRIP Professional. Place EPS files on a page created in another application and then print from that application.
**Bitmap images or clip art looks jagged**

- Bitmap images and clip art are processed for a set resolution and size. When enlarged, they tend to look jagged. EPS files produce higher-quality images.

**TIFF images and simple text files do not print**

- TIFF images and simple text files are designed to be placed into other documents. They cannot be processed directly by StylusRIP Professional. Place these files on a page created in another application and then print from that application.

**There are white lines on the output**

- Screen savers interrupt the CPU during the printing process. Turn off your screen saver.
- Run a self test on the printer to verify that you have no clogged nozzles.

**StylusRIP Professional does not run from Navigator or other special desktops**

- StylusRIP Professional runs from Windows and may not run from special desktops like Navigator. If you are using a special desktop, click the Windows icon, then click the StylusRIP Professional icon.

**Printout has misplaced images or type**

- You may not have enough memory to run StylusRIP Professional. If you have other applications open, print to the StylusRIP Professional directory and then launch StylusRIP Professional.
- You may need to install more RAM in your system.
**PPD in PageMaker 6.0 is missing**

- To install the StylusRIP Professional PPDs for PageMaker 6.0, follow these steps:

  1. Select Start, Find, Files or Folders.
  2. In the Named box, type in *.ppd and click Find Now.
  3. Click the appropriate PPD name.
  4. On the Edit menu, select Copy and copy the file to the appropriate PageMaker directory, for example C:\PM6\RSRC\USENGLISH\PPD4.

**Color matching differs during offset printing with Windows Application despite the fact that the product’s CMYK simulation function is in use**

The colors of the printed product seem to differ because of different styles of lighting. The printing simulation function presumes that printed products will be viewed under lighting with a correlated color temperature of 5,000K°. It is therefore recommended that the printout be viewed under standard lighting equivalent to 5,000K°.

**When a problem occurs with ECP mode**

- If a print problem occurs in ECP mode when using the StylusRIP Professional utility, such as incorrect characters or blank pages are output, change from ECP mode to Comptible (or Nibble) mode in your computer’s BIOS setting. For details how to change the BIOS setting, see your computer’s manual.
Glossary

**CPSI**
Configurable PostScript Interpreter. This Adobe Level 3 PostScript Interpreter runs on a Macintosh server rather than on a hardware peripheral device. StylusRIP Professional uses this interpreter to render a raster image.

**EPS**
Encapsulated PostScript. This is a file type that may contain complex graphics. It is designed as a universal format to include complex graphics in other applications.

**FPU**
Floating Point Unit. A chip capable of executing operations with real numbers.

**ICC**
International Color Consortium. A consortium of operating-system vendors that has agreed to a standard color matching system for device profiles.

**Imaging device**
A device capable of printing a raster image on a physical medium, for example, a printer, imagesetter, or digital film recorder.

**Interpreter**
A set of software functions that convert PostScript language commands into a raster image. StylusRIP Professional uses the CPSI interpreter.

**OPI**
Open Prepress Interface. A set of PostScript language commands for defining and specifying the placement of images.

**PostScript**
An interpretive computer language developed by Adobe that describes the text, graphics, and image content of a document to a printer or other output device. PostScript is hardware, software, and network independent so your images always appear the way you want them to.

**PSPrinter driver**
A printer driver used by an application to create a PostScript file.

**Raster image**
A digital representation of an image, consisting of values that are assigned to, and represent, each dot in an image.

**Render**
The process by which PostScript language commands are interpreted and a raster image is produced.
**RIP**
Raster Image Processor. An application or device that translates PostScript data into dots that can be printed.

**PSserver**
A PC running the PSserver application.

**TIFF**
Tagged Image File Format. A standard image file format consisting of labeled fields.
Index

A
Adobe PostScript, 6

B
Bitmap, 57

E
EPS, 56

P
PSserver, 34

S
System reqirement, 7

T
TIFF, 57
<table>
<thead>
<tr>
<th>Company</th>
<th>Address</th>
<th>Phone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Epson America, Inc.</strong></td>
<td>3840 Kilroy Airport Way, Long Beach, CA 90806</td>
<td>(562) 981-3840</td>
<td>(562) 290-5220</td>
</tr>
<tr>
<td><strong>Epson UK Ltd.</strong></td>
<td>Campus 100, Maylands Avenue, Hemel Hempstead, Herts, HP2 7TJ, U.K.</td>
<td>(+44) 01442 261144</td>
<td>(+44) 01442 227227</td>
</tr>
<tr>
<td><strong>Epson Deutschland GmbH</strong></td>
<td>Zülpicher Straße 6, 40549 Düsseldorf Germany</td>
<td>(0211) 56030</td>
<td>(0211) 5047787</td>
</tr>
<tr>
<td><strong>Epson France S.A.</strong></td>
<td>68 bis, rue Marjolin, 92300 Levallois-Perret, France</td>
<td>33.1.41.86.26.56</td>
<td>610657</td>
</tr>
<tr>
<td><strong>Epson Australia Pty. Ltd.</strong></td>
<td>70 GIBBES STREET, CHATSWOOD 2067 NSW.</td>
<td>2-9903-9000</td>
<td>2-9903-9177</td>
</tr>
<tr>
<td><strong>Epson Singapore Pte. Ltd.</strong></td>
<td>No. 1 Temasek Avenue #36-00 Millenia Tower, Singapore 039192</td>
<td>(065) 33 77 911</td>
<td>(065) 33 41 185</td>
</tr>
<tr>
<td><strong>Epson Hong Kong Ltd.</strong></td>
<td>Rooms 4706-10, 47/F, 26 Harbour Road, Wanchai, Hong Kong</td>
<td>2585-4300</td>
<td>2827-7083</td>
</tr>
<tr>
<td><strong>Epson Taiwan Technology &amp; Trading Ltd.</strong></td>
<td>10F, No. 287 Nanking E. Road, Sec. 3, Taipei, Taiwan,</td>
<td>(02) 2717-7360</td>
<td>(02) 2712-9164</td>
</tr>
<tr>
<td><strong>Epson Italia S.p.A.</strong></td>
<td>V.le F.Lli Casiraghi 427, 20099 Sesto S.Giovanni, MI, Italy</td>
<td>+3902262331</td>
<td>+39022440750</td>
</tr>
<tr>
<td><strong>Epson Iberica S.A.</strong></td>
<td>Av. de Roma, 18-26, 08290 Cerdanyola del Valles, Barcelona, Spain</td>
<td>582.15.00</td>
<td>582.15.55</td>
</tr>
<tr>
<td><strong>Seiko Epson Corporation</strong></td>
<td>80 Harashinden, Hirooka Shijoji-shi, Nagano-ken, 399-0785, Japan</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Epson Portugal S.A.</strong></td>
<td>R. do Progresso, 471, 1º Perafita 4460 Matosinhos, Portugal</td>
<td>(02) 996 14 02</td>
<td>(02) 996 14 11</td>
</tr>
</tbody>
</table>

2002 January